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SiGninG OnTo log on to Knowledge Forum:

 1. Type your Knowledge Forum URL address in http://yourmachinename:port#/ 
format in your browser. The “Welcome to Knowledge Forum” window appears.

 2. Select a language from the Language drop-down list.

 3. Select a database from the database drop-down list.

 4. Choose the ui Mode, Basic, to match this Quick Reference section.

 5. Type your username in the username field.

 6. Type your password in the Password field.

 7. Click Sign On.

Knowledge Forum opens to a view.

a VieW

Toolbar 
See below.

Movie 
Click to open.

attachment 
Click to open.

note 
Click to read note.

Select option for 
displaying notes in 
the view.

The do action drop-
down list allows you to 
move or clear selected 
objects, and create 
headings.

View Title

View Link 
Click to go to view.

While the toolbar 
appears on every 
view, some  
buttons may not 
be available to 
you depending on 
your user type.

 BaSic 

THe TOOLBaR

new View Link 
To add a view link to a view

new note 
To create a new note

new attachment 
To add an attachment to a view

Scaffolds 
To view, add, or edit scaffolds

authors  
To view, add, or edit authors, 
groups, and registration codes

Search 
To search the database

new Movie 
To add a movie to a view

View List 
To find or create a view

My Reader 
To access My Reader

Logout 
To exit Knowledge Forum

applet List 
To access third party applets

Help 
To get online help

View Headings 
Highlight and 
organize selected 
objects.

Picture 
Click to open.
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SiGninG On
To log on to Knowledge Forum:

 1. Type your Knowledge Forum URL address in http://yourmachinename:port#/ 
format in your browser. The “Welcome to Knowledge Forum” window appears.

 2. Select a language from the Language drop-down list.

 3. Select a database from the database drop-down list.

 4. Choose the ui Mode, Enhanced, to match this Quick Reference section. 

 5. Type your username in the username field.

 6. Type your password in the Password field.

 7. Click Sign On.

Knowledge Forum opens to a view.

a VieW

Toolbar 
See below.

Movie 
Double click 
to open.
attachment 
Double click 
to open.

note 
Double click to 
read note.

View Title
View Link 
Double click to go 
to view.

 e n H a n c e d 

While the toolbar 
appears on every 
view, some 
buttons may not 
be available to 
you depending on 
your user type.

THe TOOLBaR

new View Link 
To add a view link to a view

new note 
To create a new note

new attachment 
To add an attachment to a view

Scaffolds 
To view, add, or edit scaffolds

authors  
To view, add, or edit authors, 
groups, and registration codes

Search 
To search the database

new Movie 
To add a movie to a view

View List 
To find or create a view

My Reader 
To access My Reader

Logout 
To exit Knowledge Forum

applet List 
To access third party applets

Help 
To get online help

View Headings 
Highlight and 
organize selected 
objects.

Links Shows build-on or 
reference links.

info
About the view.

Menu options



cReaTinG a nOTe

 1. Click . The New Note window appears.

 2. Complete the basic note features. You do not need  
to use every feature when creating a note. The 
basic note features consist of the Title, in View, 
Scaffold, content, Reference, keywords, and 
Problem sections. 

 3. Click advanced to access the advanced note 
features. You do not need to use the advanced 
features to create a note. In advanced mode, 
you can add co-authors, hide or display image 
attachments, and nominate a note for publication.

 4. Click close and contribute.

The note appears in read mode as it is added to 
the view.

Type the note’s title.

Select the view to 
add the note to.

Type the problem. Type the keywords.

Click to access the advanced note features.Click to save the note and close the window.

Select a note, 
view, attachment, 
or movie to  
reference from 
the  corresponding 
Reference drop-
down list.

Type content.

Add scaffold supports:

 • Select a scaffold 
from the Scaffolds 
drop-down list. 

 • Select a scaffold 
support from the 
Scaffold list box. 

 • Click add. 

 • Type the scaffold 
support text in 
the content field 
between the > 
< symbols of the 
scaffold support’s 
HTML code.

RefeRencinG
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cReaTinG a nOTe

 1. Click . The New Note window appears.

 2. Complete the basic note features. You do not need 
to use every feature when creating a note. The 
basic note features consist of the note contents, 
problem, scaffolds, and keywords. 

 3. In the File menu, select Save. You will be  
prompted for a title for the note and you can 
select the view in which this note will appear.  

The note icon will be added to the view and the note 
window will remain open.

Click to create a 
build-on note.

Click to access 
pull-down menus.

Type in keywords.Use keyword tool to 
select keywords in 
note contents.

Shows connections to 
other notes and views.

Shows authors and allows 
you to add co-authors.

Type content. 
Drag and drop 
movies,  
attachments, 
notes and views.

Add scaffold supports:

 • Select a scaffold 
from the Scaffolds 
pull-down list. 

 • Select a scaffold 
support by double-
clicking the support, 
or click the  
Add button.   

RefeRencinG

Whole note 
Drag and drop the note icon to reference into the  
content field of the referencing note.

Part of a note (Quoting) 
Open the referenced note and copy the text you wish 
to quote, then paste into the content field of the  
referencing note.

View 
Drag and drop the view icon to reference into the  
content field of the referencing note. 

Web Page 
Type the Web link in http:// format in the content field 
of the note.
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Click to create  
an annotation.

Type the  
problem.

Shows authors, last date 
modified, and a link to 
Note history.

Whole note 
Select the note to reference from the note drop-down 
list in the Reference section of the referencing note.

Part of a note (Quoting) 
Open the referenced note and copy and paste the 
text you wish to quote between the > < symbols in 
the content field of the referencing note.

View 
Select the view to reference from the View drop-down 
list in the Reference section of the referencing note.

Web Page 
Type the Web link in http:// format in the content field 
of the note.

Movie Segment 
Open the movie. Set the start and end points of the 
movie segment and click Produce Movie Segment. 
Copy the movie segment’s HTML code into the 
content field of the referencing note.

HTML code for each reference will be added to the 
content field of your note.



cOnnecTinG ideaS

aTTacHMenTSMOVieS

To add an attachment to a view:

 1. Click . The New Attachment  
window appears.

 2. Type the title in the Title field.

 3. Click choose file. The Open  
window appears.

 4. Select the file to attach.

 5. Click choose. 

 6. In the New Attachment window, select the 
view to add the attachment to.

 7. Click close and contribute.

To add an existing movie to a note:

 1. Select a movie from the Movie drop-down 
list in the Reference section.

 2. Click close and contribute.

To add a new movie to a note:

 1. Select create new movie from the Movie 
drop-down list in the Reference section. The 
New Movie window appears.

 2. Complete the New Movie window.

 3. Click close and contribute to save the note.

In addition to referencing, you can connect ideas in 
Knowledge Forum using several different methods.

Rise-above note 
From a view, check the notes you want to rise above 
(including notes from other users) and select new 
Rise-above from the do action drop-down list. 
Complete the creation of the new rise-above note.

Build-On note 
In read mode, click Build-on in the note you want to 
build on. Complete the creation of the build-on note.

co-authors 
In advanced mode, add or remove authors from the 
authors section of the note.

Publish 
In advanced mode, click the candidate for 
Publication check box.

annotate 
In read mode, click annotate and type your annotation 
in the annotation field of the New Annotation window.

To add an existing attachment to a note:

 1. Select an attachment from the attachment 
drop-down list in the Reference section. 

 2. Click close and contribute.

To add a new attachment to a note:

 1. Select create new attachment from the 
attachment drop-down list in the Reference 
section. The New Attachment window 
appears.

 2. Complete the New Attachment window.

 3. Click close and contribute to save the note.

attachment drop-down list

To add a movie to a view:

 1. Click . The New Movie window appears.

 2. Type the 
title in the 
Title field.

 3. Click 
choose 
file next 
to the file field. The Open window appears.

 4. Select the movie file to attach.

 5. Click choose. 

 6. In the New Movie window, select the view to 
add the movie to.

 7. Select the playback option.

 8. If you want to add a poster frame:

  Click choose file next to the Poster frame.  
The Open window appears.

   Select a .jpg file to associate with the  
 movie. Click choose.

 9. In the New Movie window, click close  
and contribute.                            
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To add an existing movie to a note:

1. Drag and drop a movie icon from a view or  
note into the content field of your note.

To add an existing attachment to a note:

 1. Drag and drop an attachment icon from  
a view or note into the content field of  
your note. 

cOnnecTinG ideaS

aTTacHMenTS

To add an attachment to a view:

 1. Click . The New Attachment 
window appears.

 2. Type the 
title in 
the Title 
field.

 3. Click 
choose file. The Open window appears.

 4. Select the file to attach.

 5. Click choose. 

 6. In the New Attachment window, select the 
view to add the attachment to.

 7. Click close and contribute.

In addition to referencing, you can connect ideas in 
Knowledge Forum using several different methods.

Build-On note 
In the note editor, click Build-on in the note you  
want to build on. Complete the creation of the  
build-on note.

co-authors 
From the Authors button, add or remove authors for 
the note.

Rise-above note 
From a view, select the notes you want to rise above 
(including notes from other users) and select Rise-
Above from the Objects menu. Complete the creation 
of the new Rise-Above note.

annotate 
In the note editor, click annotate and type your  
annotation in the new Annotation window.
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To add a movie to a view:

 1. Click . The New Movie window appears.

 2. Type the  
title in the 
Title field.

 3. Click 
choose 
file next 
to the file field. The Open window appears.

 4. Select the movie file to attach.

 5. Click choose. 

 6. In the New Movie window, select the view to 
add the movie to.

 7. Select the playback option.

 8. If you want to add a poster frame:

  Click choose file next to the Poster frame.  
The Open window appears.

   Select a .jpg file to associate with the  
 movie. Click choose.

 9. In the New Movie window, click close  
and contribute.                            

MOVieS

To move an existing movie to different view:

1. Use copy and paste from the File menu to  
copy the movie and paste it in the new view.

To move an existing attachment to different view:

 1. Use copy and paste from the File menu to  
copy the attachment and paste it in the  
new view.
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SeaRcHinG

Search for objects by text in the object body, author, keyword, note title, view title, problem, scaffold support, 
user group, date created, date last modified, unread, references to your notes, and, for editors and managers, 
status and accessibility. The initial criterion chosen will determine the remaining Search fields available. 

To perform a search:

1 . Check or uncheck the notes, Views, attachments, and Movies check boxes to indicate the Knowledge 
Forum objects to search for.

 2. Select the initial criterion from the first Search drop-down list.

 3. Select from the second Search drop-down list (if applicable).

 4. Either type the search term in the text field or select from the third drop-down list (if applicable).

5. Click find. 
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From a view, click  to access the View List window.

 1. Click . The New View Link window appears.

 2. Select the view to link to from the choose a view drop-down list.

cReaTinG a VieW Link

THe VieW LiST

Click the check 
box to select 
the view link.

Click the view 
link to access 
the view.

Copy selected view links to My Hotlist or other views by using the do action drop-down list.

Select the type of views 
to display from the Show 
drop-down list.

To create a view link in a view:

Click to create a new view.
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SeaRcHinG

Search for objects by text in the object body, author, keyword, note title, view title, problem, scaffold support, 
user group, date created, date last modified, unread, references to your notes, and, for editors and managers, 
status and accessibility. The initial criterion chosen will determine the remaining Search fields available. 

To perform a search:

 1. Check or uncheck the notes, Views, attachments, and Movies check boxes to indicate the Knowledge 
Forum objects to search for.

 2. Select the initial criterion from the first Search drop-down list.

 3. Select from the second Search drop-down list (if applicable).

 4. Either type the search term in the text field or select from the third drop-down list (if applicable).

 5. Click find.
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From a view, click  to access the View List window.

 1. Click . The New View Link window appears.

 2. Select the view to link to from the choose a view drop-down list.

cReaTinG a VieW Link

THe VieW LiST

Click the check 
box to select 
the view link.

Click the view 
link to access 
the view.

Copy selected view links to My Hotlist or other views by using the do action drop-down list.

Select the type of views 
to display from the Show 
drop-down list.

To create a view link in a view:

Increase the  
number of  
search criteria to 
narrow the search.

Set notification in 
order to receive  
e-mail with updated 
search results.

Click to create a new view.

Saved searches 
listed for future use.

Save search criteria.

Increase the  
number of  
search criteria to 
narrow the search.

Set notification in 
order to receive  
e-mail with updated 
search results.

Saved searches 
listed for future use.

Save search criteria.




